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Chapter 1. MakeAFP Fonter Overview 
 
MakeAFP Fonter is a suite of programs that transform TrueType, OpenType, and 
Postscript Type 1 outline fonts into fonts that can be used for AFP printing, PDF2AFP, 
and AFP2PDF transformation, as well as empower you to view and edit the AFP bitmap 
and outline fonts. 
 

By using MakeAFP Fonter, you can easily create your fonts for AFP printing, enabling 
you to create fonts with different styles and sizes so that you can print AFP documents 
and reports with your customized styles. 
 

Functions at a Glance 
 
MakeAFP Fonter provides the following advanced features and functions helping you to 
create your AFP fonts at ease: 
 

• Converts TrueType, OpenType, and Postscript Type 1 outline fonts to AFP Type 1 
outline fonts, encoding by ASCII, EBCDIC. 

• Converts TrueType and OpenType outline fonts to AFP CID-keyed outline fonts, 
encoding by ASCII, EBCDIC, DBCS-PC( BIG5, GBK, HKSCS, KSC, SJIS), DBCS-HOST, 
and Unicode UTF-16BE. 

• Converts TrueType and OpenType outline fonts to Postscript Type 1 or CID-keyed fonts. 

• Transforms TrueType, OpenType, and Postscript Type 1 outline fonts to AFP bitmap 
fonts in 240/300/360/480/600/720 dpi, encoding by ASCII, EBCDIC, DBCS-PC(BIG5, 
GBK, HKSCS, KSC, SJIS), and DBCS-HOST.  

• Transforms legacy AFP bitmap fonts to AFP FOCA outline fonts, and Postscript Type 1 
outline fonts for AFP2PDF transformation. 

• Instant views and edits AFP font bitmap patterns, outline contours, coded fonts, and 
codepages, as well as edits Postscript Type 1 and CID fonts. 

• Adds and designs own double-byte UDC (User Define Characters) characters. 

• Exports AFP FOCA outline fonts as Postscript Type 1 or CID-keyed fonts. 

• Imports and transforms character bitmap images into outline glyphs. 

• Fully compatible with IBM AFP codepages for ASCII, EBCDIC, DBCS-HOST, and UTF-
16BE. 

• High-performance font conversion and transformation with superior font quality and 
small font file size. 
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MakeAFP Fonter Prerequisites  
 

Here are the prerequisites to run MakeAFP Fonter: 
 

1. Windows 7 or above.  
2. Microsoft Visual C++ 2010 Service Pack 1 Redistributable Package.  
 

Starting MakeAFP Fonter  
 

To invoke MakeAFP Fonter: 
 

1. Click the Start button. 
2. Select Programs, MakeAFP Software, MakeAFP Fonter, and then MakeAFP Font 

Converter or MakeAFP Font Editor. 
 

 

MakeAFP Font Converter Interface  
 

MakeAFP Font Converter provides all the tools and options you need to create the AFP 
fonts.  
 
The following overview identifies some basic features of the MakeAFP Font Converter 
graphical interfaces.  

 
Top Portion of the Interface 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Title Bar - shows the 
name of the active 
code page. 

Menu Bar - gives access to most 
features. Menus are contextual. 

Main Toolbar - gives quick access to 
frequently used functions such as select a 
TrueType, OpenType font, select an AFP 
codepage and generate AFP font, etc. 

http://www.makeafp.com/formatter4.htm
http://www.makeafp.com/formatter4.htm
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Middle Portion of the MakeAFP Font Converter Interface 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

MakeAFP Font Editor Interface  
 

MakeAFP Font Editor provides all the tools and options you need to edit the AFP fonts.  
 

The following overview identifies some basic features of the MakeAFP Font Editor 
graphical interfaces.  

 
 

Top Portion of the Interface 
 
 
 
 
 
 
 
 
 
 

 
 

AFP Code Matrix Pane - shows 
the AFP characters that are 
available in the selected font and 
AFP codepage in 16 rows and 16 
columns. The row and column 
numbers form the code point to 
which the font character in the  
corresponding position is 
assigned. 

Symbols Unicode Matrix  
Pane  – shows the characters 
available from the selected 
TrueType, OpenType or 
Postscript Type 1 font. 
 

You may resize or reposition  
the Symbols pane, or reset it 
back to the default size and 
position by double clicking its 
title bar. 

Title Bar - shows the 
name of editing AFP 
font. 

Menu Bar - gives access to most 
features. Menus are contextual. 

Main Toolbar - gives quick access to 
frequently used functions such as open font, 
save font, font properties, code matrix 
display style, etc. 

Pop-up Dialog – by 
right-clicking, shows 
the options available 
to handle a character 
or save AFP codepage. 



 

- 4 - 
 

Middle Portion of the MakeAFP Font Editor Interface 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
   

AFP Code Matrix Pane - shows 
the AFP characters that are 
available in the opened AFP 
coded font.  
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Chapter 2. Getting Started with MakeAFP Font Converter 
 
The MakeAFP Font Converter graphical interface is similar to most Microsoft Windows-
based software interfaces. Additional features are available and their purposes are 
outlined in the following narrative.  

 
 
 

Using the Menu Bar  
 

Available options and shortcut keys are displayed adjacent to the item, and menu options 
are context-sensitive.  

 

 

 

 

 

 

 
 

You can also access an item in the Menu Bar by ALT + the underscored letter in the 
Menu Bar. For example, ALT+F brings up the File Menu.  

Options Under the Menu Bar  
 

Most of the options under the Menu Bar should be self-explanatory to any experienced 
computer user.   

 
The Menu Bar and options are listed in the following tables sequentially: 

 
Menu Option Functions 
 

File  
 

 

File Menu appears as in the following figure: 
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Menu Option Functions 

File  
 

 

The File Menu options available are:  
 

Generate AFP Bitmap Font – generates AFP bitmap fonts. 
Generate AFP Outline Font – generates AFP outline Type 1 or  
                                                      CID-keyed outline fonts. 
Generate AFP Outline Font – generates AFP outline Type 1 or  
                                                      CID-keyed outline fonts. 
Codepage Save As – saves user custom codepage. 
Load Font – loads a TrueType and Postscript Type 1 font from the  

font file. 
Load Codepage – loads an AFP codepage from the user’s codepage 
                                file. 
Print Preview  – Previews the printing of matrix table(s) of AFP  
                              codepage. 
Print – Prints the matrix table(s) of AFP codepage to a Windows    
             printer.  
Exit - closes the active window. 
 

 

Edit  
 

 

The Edit Menu offers these options:  
 

 
 

Undo - takes you one step back in the order of the operations you have 
             performed.  
Redo - takes you one step forward in the order of the operations you 
             have performed.  
Cut - removes an AFP character code point. 
Copy - makes a copy of AFP character code point.  
Paste - takes a copy of AFP character code point in memory and places  
             it in is the AFP codepage matrix.  
Replace Character – replaces a character in AFP codepage. 
Remove Character – removes a character from AFP codepage.  
Section Management – manages the DBCS bitmap font sections.  
 

 

View  

 

 

The View Menu offers these options:  
 

 
 
Toolbars – displays the standard toolbars.  
Symbols – displays the pane of symbols of selected TrueType/  
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                    OpenType, or Postscript Type-1 fonts. 
Status Bar – displays the status bar at the bottom.  
Rotation – rotates the display of the characters.  
 

 

Options 

 
The Options Menu allows you to customize the default options. 
 

 
 
Customize Options - defines the default options to customize your font 
                                       converter. 
 

Font management – adds and manages the user’s Postscript Type 1 and  
                                     TrueType/OpenType fonts. 
 

Codepage Management – adds and manages user’s own AFP code- 
                                               pages. 
 

Theme – chooses a color theme for your GUI. 
 

Language – chooses a preferred language for the User’s Interfaces, as  
                      well as creates new language file and edits/updates a  
                      language file. 
 

 
 
 

 

Using Standard Toolbar  
 

MakeAFP Font Converter contains a user-friendly graphical interface to help you create 
AFP fonts at ease. The main tools are arranged on toolbars for convenient access. Many of 
them are also available on the menus. 
 
 

 
 
 

Tool Function 

 
  Font List Select Panel 

Let's select a Windows installed 
outline font. 

 
AFP Codepage Select Panel 

 

Let's select an AFP ASCII/EBCDIC/ 
DBCS-PC/DBCS-HOST codepage to 
be used for AFP font creation. 
 

 
DBCS Section 

 

Let's select a DBCS font section 
quickly if the current AFP codepage 
selected is a DBCS codepage. 
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Generate AFP Bitmap Font 

Let's generate AFP bitmap fonts. 

 
Generate AFP Outline Font 

Let's generate AFP outline fonts. 

 

Generating AFP Bitmap Fonts  
 

MakeAFP Font Converter provides a user-friendly GUI (see its picture on the next page) 
for defining and generating AFP bitmap fonts quickly, with which you can define the 
AFP bitmap font naming convention, font sizes, AFP output directory, and select a font 
resolution at ease.   
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The following font naming convention is recommended for the AFP ASCII/EBCDIC 
bitmap coded fonts:    

 

X 0    T T       S     P P       L   
 
 
 
 
 
where:   

 
 

 
  
 

 
 
 

AFP coded 
fonts 
Identifier 
(obligatory) 

Typeface name, 
like AR for 
Arial, HE for 
Helvetica 

Font Style, like 
use N for normal, 
B for bold, I for 
italic, Z for bold-
italic, or 0 for 
normal, 1 for 
Italic, 2 for Bold, 3 
for Bold Italic, etc 

Font size in 
points, like 10 
for 10 points, 36 
for 36 points, 
etc 

Language ID, 
like E for 
English, T for 
Thai, etc 
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Generating AFP Outline Fonts and Postscript fonts 
 

AFP Type 1 outline font can be generated if an AFP 1-byte ASCII/EBCDIC codepage is 
selected. 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

You may add more ASCII/EBCDIC codepages and coded fonts if you need to put more 
glyphs in  an AFP character set that supports multiple languages. 
 
AFP CID-Keyed outline font can be generated if an AFP DBCS codepage is selected for 
the DBCS-PC/DBCS-HOST/UTF-16BE encoding. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
AFP CID outline font is able to support both SBCS and DBCS coded points in one 
character set, you may add more SBCS codepage(s) and coded font(s) if required. 
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With the option “Only include the glyphs requiring by the codepage(s)”, you can 
generate a smaller AFP character set that only includes the glyphs required by your 
codepage(s).  
 

With the option "Export Type 1 Font" or “Export CIDFont and CMaps”, you can also 
generate a Postscript font in Adobe Type 1 PFB or CID-Keyed font format if you need 
such Postscript font to be used directly by your PDF or AFP2PDF applications, like IBM 
and InfoPrint AFP2PDF Transforms.  
 

The following font naming convention is recommended for AFP outline coded fonts:    
 

X Z    T T       S     0 0       L   
 
 
 
 
 
where:   

 
 

 
  
 

 
 
 

Changing AFP Codepage Matrix Display Order  
 

MakeAFP Font Converter provides a flexible user-friendly interface, with which you can 
quickly switch the display order of the AFP codepage matrix, by double-clicking the top-
left corner of the AFP codepage matrix.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

AFP coded 
fonts 
Identifier 
(obligatory) 

Typeface name, 
like AR for 
Arial, HE for 
Helvetica 

Font Style, like 
use N for normal, 
B for bold, I for 
italic, Z for bold-
italic, or 0 for 
normal, 1 for 
Italic, 2 for Bold, 3 
for Bold Italic, etc 

You may use 
00, outline font 
size is  scalable 
and control by 
your AFP 
applications 
 

Language ID, 
like E for 
English, T for 
Thai, etc 
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Changing AFP Codepage Mapping 
 

MakeAFP Font Converter empowers you able to change AFP codepage mapping at ease, 
by the cut/copy/paste/undo/redo edit features, as well as drag/drop a character within 
the codepage matrix, or copy/drag a character from the Unicode Symbols pane and then 
paste & drop to the codepage matrix pane. 
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Chapter 3. Getting Started with MakeAFP Font Editor 
 

The MakeAFP Font Editor graphical interface is similar to most Microsoft Windows-
based software interfaces, with which you can view and edit AFP SBCS/DBCS bitmap 
font patterns, outline glyphs, and codepages at ease.  

 

Using the Menu Bar  
 

Available options and shortcut keys are displayed adjacent to the item, and menu 
options are context-sensitive.  
 

 
 

You can also access an item in the Menu Bar by ALT + the underscored letter in the 
Menu Bar. For example, ALT+F brings up the File Menu.  

Options Under the Menu Bar  
 

Most of the options under the Menu Bar should be self-explanatory to any experienced 
computer user.   

 
The Menu Bar and options are listed in the following tables sequentially: 
 

Menu Option Functions 
 

File  
 

 

The File Menu options available are:  
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Menu Option Functions 
File  
 

 

Open - opens an AFP character-set/coded-font, or a Type 1 or CID   
             font. 
Save - saves the edited font. 
Save As - saves the edited font under a new name. 
Save All – saves all the edited fonts. Font Editor supports to edit  
                   multiple font files simultaneously. 
Print Preview  – previews the printing of matrix table(s) of patterns,  
                              glyphs, or AFP codepage. 
Print – prints the matrix table(s) of AFP codepage to a Windows  
             printer. Recent Files – shows the recently accessed files. 
Exit - closes the active window. 
 

 

Edit  
 

 

The Edit Menu offers these options:  
 

 
 

Undo - takes you one step back in the order of the actions you have 
             performed.  
Redo - takes you one step forward in the order of the actions you 
             have performed.  
Cut - removes a character and puts it on the clipboard. 
Copy - makes a copy of a character and keeps it in the clipboard.  
Paste - takes a copy of the character from the clipboard.  
Edit Character – let’s edit a character’s pattern or contours.  
Rename Character ID – Let’s rename a character’s ID.  
Insert Character – let’s insert a character.  
Remove Character – Let’s remove a character. 
Font Properties – allows you to view and edit the properties of AFP  
                                font, as well as add the sections for the DBCS  
                                bitmap fonts. 
 

 

View  
 

 

The View Menu offers these options:  
 

 
 

Toolbars – displays the standard too bars.  
Status Bar – displays the status bar at bottom.  
Codepage – loads an AFP codepage.  
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Options 

 

The Options Menu allows you to customize the default options. 
 

 
 

Customize Options – Let’s customize the options. 
Theme – chooses a color theme for your GUI. 
Language – chooses a preferred language for the Menu, edits the  
                      language files. 
 

 
 

 

Using Standard Toolbar  
 

MakeAFP Font Editor contains a user-friendly graphical interface to help you to edit AFP 
fonts at ease. The main tools are arranged on toolbars for convenient access. Many of 
them are also available on the menus. 
 

 
 
 

Tool Function 

 
Open Font 

Let’s open an existing AFP font. 

 
Save Font 

Let’s save the current edited AFP font. 

 
Cut 

Let’s cut a character and put it on the 
clipboard. 

 
Copy 

Let’s make a copy of a character and keep 
it on the clipboard.  

 
  Paste 

 

Let’s take a copy of the character from the 
clipboard.  

 
Undo 

Let’s take one step back in the order of the 
actions you have performed.  

 
Redo 

Let’s take one step forward in the order of 
the actions you have performed.  

 
Edit Character Pattern 

 

Let’s edit the character pattern, you can 
do it also by double-clicking the character 
on the main codepage matrix pane to 
open the “Edit Character Pattern” 
window directly. 
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Font Properties 

Let’s view and edit the font properties of 
an AFP font. 

 
Matrix Style 

Let’s select a matrix style of display 
window. 

 
Section 

Let’s quickly switch to a section of DBCS 
font. 

 
Rotation 

Let’s switch the display rotation of AFP 
characters. 

 
Scale 

Let’s quickly scale the display size of the 
bitmap font, if a bitmap font is opened. 

 
Font Size 

Let’s quickly change the display size of 
the outline font, if an outline font is 
opened 

 
 

Editing Bitmap Character Pattern  
 

By double-clicking a bitmap character on the main Codepage Matrix or Pattern Matrix 
pane, you can modify its bitmap pattern and properties by using the window of Edit 
Character Pattern.  
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

You may resize or reposition the 
Character Properties pane, or reset it 
back to the default size and position by 
double click its title bar. 
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Drawing Tools for Edit Bitmap Pattern  
 

Drawing tools are provided to empower you to quickly edit, draw, copy, paste and move 
bitmap patterns.   
 
 
 

 

Tool Function 

 
Save 

Let’s save the current edited bitmap 
pattern. 

 
Cut 

Let’s Cut the selection and put it on the 
clipboard. 

 
Copy 

Let’s Copy the current selection to the 
clipboard. 

 
  Paste 

 

Let’s Paste the last item on the clipboard 
into the current pattern drawing window 

 
Undo 

Let’s reverse the last action. 

 
Redo 

Let’s reverse Undo. 

 
Pencil 

Let’s draw or erase (by right-click) bitmap 
pattern dot-by-dot precisely. 

 
Brush 

Let’s draw or erase (by right-click) bitmap 
pattern with dots. 

 
Character Pattern 

Let’s quickly create a character pattern by 
taking the bitmap pattern from an existing 
outline font. 

  
Line 

Let’s draw or erase (by right-click) a Line. 

 
Rectangle 

Let’s draw or erase (by right-click) a 
Rectangle. 

 
Filled Rectangle 

Let’s draw or erase (by right-click) a Filled 
Rectangle. 

 
Ellipse 

Let’s draw or erase (by right-click) an 
Ellipse. 

 Let’s draw or erase (by right-click) a Filled 
Ellipse. 
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Filled Ellipse 

 
Rectangle Selection 

Let’s select a rectangle area of the pattern 
to copy, cut, delete, or move. 

 
Irregular Selection 

Let’s select an irregular area of the pattern 
to copy, cut, delete, or move. 

 
Erase 

Let’s erase bitmap patterns freehand. 

 
Dot Size 

Let’s select dot size for the tools of Line, 
Rectangle, Ellipse, Erase. 

 
Zoom 

Let’s select the zoom level. 

 
Character Properties 

Shows the properties of the character. 

 
Close 

Closes the window of Edit Character 
Pattern. 

 

 

Editing Outline Glyph  
 

By double-clicking an outline character on the main Codepage Matrix or Pattern/Glyph 
Matrix pane, you can modify its vector outline glyph and properties by using the 
window of Edit Outline Glyph. While pressing Shift or Ctrl key, you can select all or part 
of the nodes by left-clicking. 
 
\ 
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Drawing Tools for Edit Outline Glyph  
 

Drawing tools are provided to empower you to quickly edit, draw, copy, paste and move 
bitmap patterns.   
 
 

 

Tool Function 

 
Save 

Let’s save the currently edited outline 
glyph. 

 
Cut 

Let’s Cut the selection and put it on the 
clipboard. 

 
Copy 

Let’s Copy the current selection to the 
clipboard. 

 
  Paste 

 

Let’s Paste the last item on the clipboard 
into the current pattern drawing window 

 
Undo 

Let’s reverse the last action. 

 
Redo 

Let’s reverse Undo. 

 
 
 

 
Selection 

 

Let’s select nodes or contours, multiple 
nodes or contours can be selected while 
pressing CTRL or SHIFT key, or by a 
selection rectangle.  
 

To deselect all nodes click the left mouse 
button somewhere in the free space of the 
editing field. 
 

You can return to Selection mode anytime 
by pressing the ESC key.  
 

 
 

 
Pen Tool 

 

Let’s add a curve control node to the 
current contour or convert node. 
 

Corner nodes may exist between any 
types of segments (straight or curve). If 
possible, you should convert a corner 
node between two curve segments into a 
curve node, and a corner node between a 
curve segment and a straight segment into 
a tangent node.  
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Contour Tool 

 

Let’s select a drawing tool to plot the 
contour, such as draw rectangle, ellipse, 
and point-by-point polygon drawing with 
easy combination of straight segments 
and curves. 
 

Contours can be of two types: black or 
white. They can also be of two directions: 
clockwise or anti-clockwise. The basic rule 
that applies to Type 1 or CID fonts is 
simple: clockwise-directed contours are 
white and anti-clockwise contours are 
black.  
 

You can control contour direction by 
selecting Tools --> Reverse Contour, then 
right-click contour to select pop-up option 
Reverse Contour or double-click the 
contour.  
 

 
Character Glyph 

Let’s quickly draw a character glyph by 
taking contours from an existing outline 
font.  

 
Set Startpoint 

Let’s manually change the start point of 
contours and re-arrange contours. 

 
Reverse Contour 

Let’s manually reverse the direction of a 
single contour. 

 
Transform 

Let’s scale, rotate or skew the selected 
portion of the outline. 

 
Grid Lines 

Let’s control whether display grid lines, 
which are useful to align the outline. 

 

 
Guide Lines 

 

Let’s control whether display the 
horizontal and vertical guidelines, which 
are useful to align the outline. You can 
insert a new guide line by dragging the 
mouse in the horizontal or vertical ruler 
area. 
 

 
 

 
Hints Lines 

 

Let’s control whether display the 
Postscript Type 1 hints lines, if your font 
includes such hints information. 
 

You can insert a new hints lines by 
dragging the mouse and pressing CTRL 
key in the horizontal or vertical ruler area. 
You can move a single hints line by 
pressing CTRL key. 
 



 

- 20 - 
 

 

 
Nodes 

 

Let’s control whether display the curve 
control nodes. 
 

You can move node position either by 
mouse or by arrow keys. 
 

 
 

Control Vectors 

 

Let’s set whether display the curve control 
vectors. 
 

PostScript Type 1 curve is Bezier type 
curve, that needs two additional sub-
nodes called Bezier control points (BCPs) 
and the vectors that connect the control 
points with the curve's ends are called 
control vectors. 
 

 
Filling 

Let’s control whether the glyph shape 
should be filled or not. 

 
Scale 

Let’s quickly scale the display size of the 
outline glyph. 

 
Close 

Closes the window of Edit Outline Glyph. 

 

Loading Codepage  
 

By option View --> Codepage  --> Load Codepage…, you can load an AFP codepage 
while you are viewing and editing a coded font or character set, and then you can select 
File --> Save As … to save your change as another coded font. 
 

Exporting Type 1 or CID-Keyed Font  
 

While on the Glyph Matrix panel, you can open the “Export Type 1 Font…” or “Export 
CID Font …” pop-up dialog by a right-click, and then export the outline font as a 
Postscript Type 1 or CID-keyed font.  
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Transforming AFP Bitmap Font to FOCA Outline and Postscript Type 1 Font  
 

While on the Codepage Matrix panel, you can open the “Export Outline FOCA (Type 
1) …” pop-up dialog by a right-click, and then export the transformed outline font as an 
AFP FOCA outline font and a Postscript Type 1 font.  
 

 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 

On the Export Outline FOCA dialog, you have to make sure the value of Bitmap FOCA 
Font Size is correct as some AFP software may generate the wrong font size value.  
 
 
 
 
 
 
 
 
 
 
 
 
 

With bitmap to outline Transform Options dialog, you can select a character bitmap 
pattern, and then preview the output quality of contours in real-time while adjusting the 
options. 
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High resolution and big point-size AFP bitmap fonts are recommended to be used for 
such a bitmap to outline transformation, and you may need to use MakeAFP Font Editor 
or a professional outline font editor to manually improve the quality of outline glyphs.  
 

 

Adding a New Character to FOCA DBCS Outline Font  
 

While on the Glyph Matrix style panel, right-click on a blank cell and select Insert Glyph 
pop-up option, to insert a new CID index number for adding the new glyph. 
 
 

 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 
 
 
 
A new CID index number is being created, you need to remember this new CID number 
just assigned.   
 
 
 
Y
o
u
 
c
a
n
 
c 
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You can copy and transform an existing glyph or contours, and then paste to the cell of a 
new glyph for the creating of the new glyph, or copy more contours from the existing 
glyphs.    
 
For example, the following new Japanese Era glyph is being created, by the transforming 
and coping from the existing two Japanese glyphs: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
After new glyphs were created, switch to the CID CMap Matrix style panel, right-click 
on the panel and select the CMap pop-up option, to select the name of CMap related to 
your AFP DBCS codepage. 
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Select the DBCS section where you need to assign your new glyph, right-click on the cell 
of new glyph and select the Insert CID Index… pop-up option. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

On the pop-up Insert CID Index dialog, type the CID index number that was previous 
assigned to the new glyph.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

- 25 - 
 

Now you can see the new glyph on the CID CMap Matrix panel.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Switch to the Codepage Matrix style panel, load the AFP DBCS codepage related with 
the CMap previous selected on the CID CMap Matrix panel, then right-click on the cell 
that is to be assigned the new AFP character. 

 
On the pop-up Insert Character dialog, type the name of AFP Character ID. You can copy 
and paste an existing character ID and then modify its name for the new character.   
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Now your new AFP character was created. 
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Appendix A. AFP Font Basic Concepts 
 

This appendix introduces some basic AFP font terminology, structure and how 
characters are represented in digitized presentation type.  

AFP Font Structure  
 

In AFP font terminology, an AFP font has three components: 
  

• Coded font  
 

• Character set   
• Codepage  

 

 
 
 
 

 
 
 

 

Coded Font 
 

AFP coded font is a font file that associates the AFP character set with AFP codepage.  
 

A bitmap coded font consists of two parts: 
  

• References to specific character sets 
• References to specific codepages 

 

An outline coded font consists of three parts: 
  

• References to specific character sets 
• References to specific codepages 
• References to point size 

Character Set 
 

AFP character set consists of a finite set of characters. It contains information about a 
font type family, typeface, and point size, and also includes each character's properties 
and its printing attributes, such as baseline positioning, rotation, ascenders, descenders, 
etc.  
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Characters 
 

Characters are the letters, numerals, marks, and symbols of a font. 
 
Character Properties 
 

Character properties detail how a character is positioned relative to the characters 
around it. Some character properties include the following: 
  
• The baseline of a character showing its general alignment 

• The dimensions of space in which the character is printed  

• The position of the character within that space  

• The identifier of the character (the character ID)  
 

One of the character properties is the character ID, named GCGID (graphic character 
global identifier). Each character is assigned a unique 8-character GCGID; for instance, 
the character uppercase A is assigned the GCGID LA020000 registered by IBM. 
 
For a list of GCGIDs, each character represents, and the codepages where the characters 
are found, refer to IBM AFP Fonts: Technical Reference for Codepages (S544-3802-02). 
 
Printing Attributes 
  
The printing attributes define how the character set will be printed, such as baseline 
positioning, rotation, ascenders, descenders, and point size, etc. 
 
Single-byte and Double-byte Character Sets 
 

A single-byte character set (SBCS) is a font character set to be used with a single-byte 
codepage. The maximum number of characters in a character set is 256. 
 
A double-byte AFP bitmap font consists of multiple sections of double-byte character 
sets (DBCS), to be used with CJK (Chinese, Japanese, Korean).  
 
Bitmap Format of Character Set 
 

AFP font character sets in bitmap format can be in 240/300/600 dpi, some printers and 
AFP print servers may support character sets in 360/480/720 dpi also. The character 
positioning values in the bitmap character set can be expressed in either fixed-metric or 
relative-metric.  
 
Outline Format of Character Set 
 

AFP outline character sets can be in SBCS outline format (by Adobe Postscript Type 1 
outline font encapsulated in AFP font architecture wrappers), or DBCS outline format (by 
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Adobe Postscript CID-keyed outlines font encapsulated in AFP font architecture 
wrappers). The character positioning values in the outline character set are expressed in 
relative-metric.  

Codepage 
 

AFP codepage maps each character of text to the characters in an AFP character set. As 
you enter your text on your keyboard, each key in character is translated into a 
hexadecimal code point. When the text is printed, each hexadecimal code point is 
matched to a GCGID on the AFP codepage you specified. The GCGID is then matched to 
the AFP bitmap pattern or outline vector pattern of the character in the AFP character set 
you specified. The character pattern in the character set is being finally used for the 
printing of your character. 
 
The following picture shows an example with AFP EBCDIC codepage T1V10037 for IBM 
mainframe USA English.  
 
When the IPDS printer receives EBCDIC hexadecimal code point C1, it prints an 
uppercase A, whose GCGID is LA020000. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
An SBCS codepage contains up to 256 one-byte code points. SBCS codepages are good 
enough for languages with alphabetic writing systems, such as English, Latin, Greek, 
Thai, and Arabic, etc. 
 
A DBCS codepage can contain up to 65536 double-byte code points for CJK (Chinese, 
Japanese and Korean) languages.  
 
For bitmap DBCS AFP fonts, AFP treats DBCS codepage as a collection of single-byte 
codepages, a double-byte is split into two parts, the first byte indicating the section 
number of the codepage and the second byte indicating a code point within the section. 
 
For outline DBCS AFP fonts, AFP treats DBCS codepage as a single large codepage. 
Each DBCS character has a 2-byte code point. 
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AFP Font Naming Convention 
 

Each AFP component’s name is only allowed up to 8 characters. The following list shows 
the prefix of the AFP font naming convention and the type of font component represents.  
 

AFP Font Name 
Prefix 

Font Component 

C0 The character set of AFP bitmap font 
CZ The character set of AFP outline font 
T1 AFP codepage 
X0 Coded font of AFP bitmap font 
XZ Coded font of AFP outline font 
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Appendix B. ASCII/EBCDIC AFP Codepages Summary 
 
 

 
Name Description CPGID Encoding 

T1000038 US-ASCII Character Set 38 EBCDIC 
T1000259 Symbols, Set 7 259 EBCDIC 
T1000260 Canadian French - 116 260 EBCDIC 
T1000276 Canada (French) - 94 276 EBCDIC 
T1000286 Austria/Germany F.R., Alt (3270) 286 EBCDIC 
T1000287 Denmark/Norway, Alternate (3270) 287 EBCDIC 
T1000288 Finland/Sweden, Alternate (3270) 288 EBCDIC 
T1000289 Spain, Alternate (3270) 289 EBCDIC 
T1000290 Japan (Katakana) 290 EBCDIC 
T1000293 APL (USA) 293 EBCDIC 
T1000310 Graphic Escape APL/TN 310 EBCDIC 
T1000361 International Set 5 361 EBCDIC 
T1000363 Symbols, Set 8 363 EBCDIC 
T1000367 ASCII 367 ASCII 
T1000382 Austria, Germany, Japan 382 EBCDIC 
T1000383 Belgium 383 EBCDIC 
T1000384 Brazil 384 EBCDIC 
T1000385 Canada (French) 385 EBCDIC 
T1000386 Denmark/Norway 386 EBCDIC 
T1000387 Sweden/Finland 387 EBCDIC 
T1000388 France, Japan 388 EBCDIC 
T1000389 ITALY, Japan (Italian) 389 EBCDIC 
T1000390 Japan (Latin) 390 EBCDIC 
T1000391 Portugal 391 EBCDIC 
T1000392 Spain/Philippines 392 EBCDIC 
T1000393 Latin America (Spanish) 393 EBCDIC 
T1000394 U.K., Austral., IRE., H.K., N.Z. 394 EBCDIC 
T1000395 United States, Canada (English) 395 EBCDIC 
T1000420 Arabic Bilingual 420 EBCDIC 
T1000423 Greece - 183 423 EBCDIC 
T1000424 Israel (Hebrew) 424 EBCDIC 
T1000437 Personal Computer 437 ASCII 
T1000803 Hebrew Character Set A 803 EBCDIC 
T1000808 PC, Cyrillic, Russian with euro 808 ASCII 
T1000813 Greece - ISO/ASCII 8-Bit 813 ASCII 
T1000819 Latin1 ISO/ANSI 8-BIT 819 ASCII 
T1000829 Math Symbols 829 EBCDIC 
T1000836 Peoples Republic of China (PRC) 836 EBCDIC 
T1000838 Thai - EBCDIC 838 EBCDIC 
T1000848 PC, Cyrillic, Ukraine with Euro 848 ASCII 
T1000849 PC, Cyrillic, Belo Russian Euro 849 ASCII 
T1000850 PC Multilingual 850 ASCII 
T1000851 Greek - Personal Computer 851 ASCII 

http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000038_103_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000259_340_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000260_341_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000276_277_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000286_317_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000287_321_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000288_325_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000289_329_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000290_332_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000293_380_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000310_963_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000361_1145_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000363_630_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000367_103_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000382_1145_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000383_1145_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000384_1145_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000385_1145_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000386_1145_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000387_1145_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000388_1145_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000389_1145_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000390_1145_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000391_1145_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000392_1145_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000393_1145_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000394_1145_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000395_1145_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000420_235_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000423_218_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000424_941_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000437_919_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000803_1147_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000808_1385_2002-07-04.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000813_925_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000819_697_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000829_909_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000836_936_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000838_1176_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000848_1390_2002-07-04.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000848_1390_2002-07-04.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000850_980_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000851_981_1994-12-16.htm
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T1000852 Latin2 Multilingual PC 852 ASCII 
T1000853 Latin3 Personal Computer 853 ASCII 
T1000855 Cyrillic - Personal Computer 855 ASCII 
T1000856 Hebrew - Personal Computer 856 ASCII 
T1000857 Latin5 PC 857 ASCII 
T1000858 PC - Multilingual with euro 858 ASCII 
T1000860 Portugal - Personal Computer 860 ASCII 
T1000861 Iceland - Personal Computer 861 ASCII 
T1000862 Hebrew - Personal Computer 862 ASCII 
T1000863 Canadian French - PC 863 ASCII 
T1000864 Arabic - Personal Computer 864 ASCII 
T1000865 Nordic - Personal Computer 865 ASCII 
T1000866 Cyrillic #2 - Personal Computer 866 ASCII 
T1000867 Israel - Personal Computer 867 ASCII 
T1000869 Greece - Personal Computer 869 ASCII 
T1000870 Latin2 Multilingual 870 EBCDIC 
T1000872 Cyrillic PC with Euro 872 ASCII 
T1000874 Thai - Personal Computer 874 ASCII 
T1000875 Greece 875 EBCDIC 
T1000876 OCR-A ASCII 876 ASCII 
T1000877 OCR-B ASCII 877 ASCII 
T1000880 Cyrillic Multilingual 880 EBCDIC 
T1000889 Thailand 889 EBCDIC 
T1000892 OCR - A 892 EBCDIC 
T1000893 OCR - B 893 EBCDIC 
T1000897 Japan PC #1 897 ASCII 
T1000899 Symbols, Set 7 ASCII 899 ASCII 
T1000901 PC, Baltic - Multilingual w Euro 901 ASCII 
T1000902 8-bit Estonia with euro 902 ASCII 
T1000903 Peoples Republic of China - PC 903 ASCII 
T1000904 Republic of China (ROC) - PC 904 ASCII 
T1000905 Latin3 Multilingual 905 EBCDIC 
T1000910 APL ASCII 910 ASCII 
T1000912 Latin2 ISO/ANSI 8-BIT 912 ASCII 
T1000913 Latin 3, ISO/ASCII 913 ASCII 
T1000914 Latin4 ISO/ANSI 8-BIT 914 ASCII 
T1000915 Cyrillic ISO/ASCII 8-Bit 915 ASCII 
T1000916 Hebrew ISO/ASCII 8-Bit 916 ASCII 
T1000920 Latin5 ISO/ANSI 8-BIT 920 ASCII 
T1000921 PC, Baltic - Multilingual 921 ASCII 
T1000922 Estonia PC 922 ASCII 
T1000923 Latin 9 923 ASCII 
T1000924 Latin 9 EBCDIC 924 EBCDIC 
T1001002 DCF REL 2 Compatibility 1002 EBCDIC 
T1001003 U.S. Text Subset 1003 EBCDIC 
T1001004 IBM PC Desktop Publishing 1004 ASCII 
T1001008 Arabic ISO/ASCII 8-Bit 1008 ASCII 
T1001025 Cyrillic Multilingual 1025 EBCDIC 
T1001026 Latin5 1026 EBCDIC 
T1001027 Japanese (Latin) Extended 1027 EBCDIC 
T1001028 Hebrew Publishing 1028 EBCDIC 
T1001029 Arabic Extended ISO/ACSII 8-Bit 1029 ASCII 
T1001032 MICR, E13-B Combined 1032 EBCDIC 
T1001033 MICR, CMC-7 Combined 1033 EBCDIC 
T1001038 Symbols, Adobe ASCII 1038 ASCII 
T1001039 GML List Symbols 1039 EBCDIC 
T1001041 Japanese Extended - PC 1041 ASCII 

http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000852_982_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000853_983_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000855_985_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000856_986_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000857_987_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000858_988_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000860_990_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000861_991_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000862_992_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000863_993_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000864_994_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000865_995_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000866_996_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000867_1360_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000869_998_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000870_959_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000872_1383_2002-07-04.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000874_1176_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000875_925_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000876_968_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000877_969_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000880_960_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000889_1102_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000892_968_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000893_969_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000897_1164_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000899_340_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000901_1394_2002-07-04.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000902_1392_2002-07-04.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000903_1166_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000904_1167_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000905_1286_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000910_1113_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000912_959_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000913_1286_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000914_1256_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000915_1150_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000916_941_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000920_1152_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000921_1346_2002-07-04.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000922_1347_2002-07-04.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000923_1353_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000924_1353_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001002_1132_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001003_1133_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001004_1146_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001008_1162_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001025_1150_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001026_1152_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001027_1172_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001028_1199_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001029_1154_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001032_1227_1998-05-29.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001033_65535_1991-10-05.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001038_1257_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001039_1258_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001041_1187_1994-12-16.htm
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T1001042 Simplified Chinese Extended - PC 1042 ASCII 
T1001043 Traditional Chinese Extended PC 1043 ASCII 
T1001046 Arabic Extended ISO/ASCII 8-Bit 1046 ASCII 
T1001068 Text With Numeric Spacing 1068 EBCDIC 
T1001069 Latin4 EBCDIC 1069 EBCDIC 
T1001087 Symbols, Adobe 1087 EBCDIC 
T1001091 Symbol Set 7, Modified 1091 EBCDIC 
T1001092 Symbol Set 7, Modified - PC 1092 ASCII 
T1001093 IBM LOGO 1093 EBCDIC 
T1001110 Latin2 Multilingual 1110 EBCDIC 
T1001111 Latin2 ISO/ANSI 8-BIT 1111 ASCII 
T1001112 Baltic - Multilingual, EBCDIC 1112 EBCDIC 
T1001122 Estonia, EBCDIC 1122 EBCDIC 
T1001123 Cyrillic, Ukraine EBCDIC 1123 EBCDIC 
T1001124 Cyrillic, Ukraine ISO-8 1124 ASCII 
T1001125 PC, Cyrillic Ukrainian 1125 ASCII 
T1001129 Vietnamese ISO-8 1129 ASCII 
T1001130 Vietnamese EBCDIC 1130 EBCDIC 
T1001131 PC, Cyrillic, Belo Russian 1131 ASCII 
T1001132 Lao EBCDIC 1132 EBCDIC 
T1001133 Lao ISO-8 1133 ASCII 
T1001139 Japan Alphanumeric Katakana 1139 ASCII 
T1001140 USA, Canada ECECP 1140 EBCDIC 
T1001141 Austria, Germany ECECP 1141 EBCDIC 
T1001142 Denmark, Norway ECECP 1142 EBCDIC 
T1001143 Finland, Sweden ECECP 1143 EBCDIC 
T1001144 Italy ECECP 1144 EBCDIC 
T1001145 Spain, Latin America ECECP 1145 EBCDIC 
T1001146 UK ECECP 1146 EBCDIC 
T1001147 France ECECP 1147 EBCDIC 
T1001148 International ECECP 1148 EBCDIC 
T1001149 Iceland ECECP 1149 EBCDIC 
T1001153 Latin2 Multilingual with Euro 1153 EBCDIC 
T1001254 Windows Turkish 1254 ASCII 
T1001257 Windows Baltic Rim 1257 ASCII 
T1001258 Windows Vietnamese 1258 ASCII 
T1001275 Apple Latin 1 1275 ASCII 
T1001276 Adobe PS Standard 1276 ASCII 
T1001277 Adobe PS ISO Latin 1 1277 ASCII 
T1001280 Apple Greece 1280 ASCII 
T1001281 Apple Turkey 1281 ASCII 
T1001282 Apple Central Europe 1282 ASCII 
T1001283 Apple Cyrillic 1283 ASCII 
T1001300 GENERIC BAR CODE/OCR-B 1300 EBCDIC 
T1005346 Latin 2 – Windows 1250 ASCII 
T1005347 Cyrillic – Windows 1251 ASCII 
T1005348 Latin 1 – Windows 1252 ASCII 
T1005349 Greece – Windows 1253 ASCII 
T1005350 Turkey – Windows 1254 ASCII 
T1005351 Israel – Windows 1255 ASCII 
T1005352 Arabic – Windows 1256 ASCII 
T1005353 Latin 4 – Windows 1257 ASCII 
T1005354 Vietnamese – Windows  1258 ASCII 
T1V10037 USA/Canada - CECP 37 EBCDIC 
T1V10273 Germany F.R./Austria- CECP 273 EBCDIC 
T1V10274 Belgium - CECP 274 EBCDIC 

http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001042_1188_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001043_1189_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001046_1177_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001068_1259_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001069_1256_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001087_1257_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001091_1191_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001092_1191_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001093_2040_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001110_1111_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001111_1111_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001112_1305_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001122_1307_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001123_1326_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001124_1326_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001125_1331_2002-07-04.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001129_1336_2002-07-04.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001130_1336_2002-07-04.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001131_1338_2002-07-04.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001132_1341_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001133_1341_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001139_1122_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001140_695_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001141_695_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001142_695_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001143_695_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001144_695_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001145_695_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001146_695_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001147_695_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001148_695_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001149_695_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001153_1375_2002-07-04.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001254_1414_2002-07-04.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001257_1421_2002-07-04.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001258_1418_2002-07-04.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001300_1450_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1V10037_697_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1V10273_697_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1V10274_697_1994-12-16.htm
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T1V10275 Brazil - CECP 275 EBCDIC 
T1V10277 Denmark/Norway - CECP 277 EBCDIC 
T1V10278 Finlandd/Sweden- CECP 278 EBCDIC 
T1V10280 ITALY- CECP 280 EBCDIC 
T1V10281 Japan (Latin) - CECP 281 EBCDIC 
T1V10282 Portugal - CECP 282 EBCDIC 
T1V10284 Spain/Latin America - CECP 284 EBCDIC 
T1V10285 UNITED KINGDOM - CECP 285 EBCDIC 
T1V10290 Japan (Katakana) 290 EBCDIC 
T1V10297 France - CECP 297 EBCDIC 
T1V10500 International #5 500 EBCDIC 
T1V10871 Iceland - CECP 871 EBCDIC 

 
 
 
 
 
 

http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1V10275_697_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1V10277_697_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1V10278_697_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1V10280_697_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1V10281_697_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1V10282_697_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1V10284_697_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1V10285_697_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1V10290_1172_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1V10297_697_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1V10500_697_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1V10871_697_1994-12-16.htm
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Appendix C. SBCS/DBCS/UTF-16BE AFP Codepages Summary 
 

 
Name Description Encoding 

T1H00037 Traditional Chinese EBCDIC EBCDIC 
T1H00290 Japanese Katakana Extended EBCDIC 
T1H00833 Korean EBCDIC EBCDIC 
T1H00836 Simplified Chinese EBCDIC EBCDIC 
T1H01002 Japanese DCF Rel 2 Compatibility EBCDIC 
T1H01027 Japanese Latin Extended  EBCDIC 

T1H01030 Japanese Katakana Extended with Box 
Characters EBCDIC 

T1H01031 Japanese Latin Extended with Box Characters EBCDIC 
T1H01041 Japanese PC Extended  ASCII 
T1H01043 Traditional Chinese PC ASCII 
T1H01114 Traditional Chinese PC BIG5 with Euro ASCII 
T1H01115 Simplified Chinese PC (GB) ASCII 
T1H01126 Korean PC ASCII 
T1H01150 Korean EBCDIC with Box Characters EBCDIC 

T1H01151 Simplified Chinese EBCDIC with Box 
Characters EBCDIC 

T1H01152 Traditional Chinese EBCDIC with Box 
Characters EBCDIC 

T1H01159 Traditional Chinese EBCDIC with Euro EBCDIC 
T1H01252 Simplified Chinese PC (GB18030) ASCII 
T1HK0037 Japanese English  EBCDIC 
T1HK0290 Japanese Katakana  EBCDIC 
T10300, T1I300, 
T1J300, T1K300 Japanese DBCS-HOST DBCS-HOST 

T10834 Korean DBCS-HOST (Small Set) DBCS-HOST 
T10835 Traditional Chinese DBCS-HOST DBCS-HOST 
T10837 Simplified Chinese DBCS-HOST (GB2312) DBCS-HOST 
T10941 Japanese SJIS-PC DBCS-PC 
T10947 Traditional Chinese  BIG5-PC DBCS-PC 
T10951 Korean KSC-PC (Small Set) DBCS-PC 
T11200 Unicode UTF-16 Big-endian UTF-16BE 
T11362 Korean KSC-PC (Big Set) DBCS-PC 
T11374 Traditional Chinese  HKSCS-PC DBCS-PC 
T11376 Traditional Chinese  HKSCS-HOST DBCS-HOST 
T11380 Simplified Chinese GB2312-PC (Small Set) DBCS-PC 
T11385 Simplified Chinese GBK-PC (Big Set) DBCS-PC 
T1K834 Korean DBCS-HOST (Big Set) DBCS-HOST 
T1K837 Simplified Chinese DBCS-HOST (GB18030) DBCS-HOST 
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Appendix D. Transferring AFP Resources 
 
Make sure FTP is in binary mode if you need to transfer AFP resources across multi-
platforms. 
 
For uploading of AFP resources to z/OS, z/VSE and z/VM, you may need to use IBM AFP 
Reblocking Utility, more information and downloads are available at IBM webpage for 
AFP software.   
 
For uploading AFP resources to OS/400, refer to Appendix D of  IBM Advanced Print 
Utility User's Guide (S544-5351) or AS/400 Guide to Advanced Function Presentation and 
Print Services Facility (S544-5319) for more information. 
 

 
 
 
 

ftp://service.boulder.ibm.com/printers/tools/mvsvmreblk
ftp://service.boulder.ibm.com/printers/tools/mvsvmreblk
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